Aurora for Windows Embedded

WINDOWS EMBEDDED DEVICE MANAGEMENT SOFTWARE

Introduction

Aurora for Windows Embedded device management software is an administrative tool based on
open Internet standards. The management console enables the administrator to remotely
monitor, update, control and configure Windows XP Embedded thin client devices.

This manual illustrates how to use the management software to deploy, configure, and
administer remote windows embedded devices. It is intended as a reference guide for system
administrators.

Features

Centralized management of XPe devices.

Stores device and other settings in a centralized SQL 2000/2005 database or SQL 2005
Express.

Centrally apply system hot fixes, application snap-in’s, application updates, firmware
reloads to single or multiple XPe devices.

Clone settings from a configured XPe device and apply to single or multiple target XPe
devices.

Join remote XPe devices to the Active Directory.

Remotely change local Administrator and User account passwords.

Remote control or shadow XPe devices.

Wake up, restart or shutdown remote XPe devices.

Organize XPe devices on LAN/WAN environments into logical groups.

Automatically group devices specified by subnet range.

Manage XPe devices in a WAN environment and devices which are behind a NAT
firewall.

Schedule tasks that need to be executed on the XPe devices.

User-friendly graphical user interface.

Easy licensing module which allows to add-on install license packs as and when new
devices are installed on the network.



Getting Started

This chapter covers:

e Overview
e Get to know the Aurora User Interface
0 Physical View

0 Logical View
0 Task View

o Status Bar
o Icons
e Before you begin
o Install license pack.

o TCP/UDP port requirements
o Configure the Aurora console to use a FTP server
o XPe device registration
o Updating the agent on the XPe device
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XPe Management Console: Consists of a graphical user interface and a server which interacts
with the XPe devices. It will also help organize devices into logical groups, create and manage
tasks and monitor tasks sent out to devices.

Microsoft Remote Boot Server (RBS): Integrated with the Aurora for Windows Embedded
software for remote firmware reloads for single or multiple XPe devices.

XPe Device: Windows XP Embedded device preloaded with Aurora XPe agents. XPe agents
register the XPe devices with the XPe management console, get task commands, execute the
commands and report their status.

FTP Server: The FTP server is used for storage of cloned settings, firmware update, hot fix and
application snapin or upgrade packages. These packages are uploaded from the Aurora
management console and downloaded to the XPe devices on command.

Database Server: The database server stores information of all the registered XPe devices. For
enterprise wide management of XPe devices, the XPe management server can be configured to
use Microsoft SQL server. To manage XPe devices in a workgroup an integrated Microsoft SQL
Server 2005 Express edition is provided with the installation package.

Get to know the Aurora interface

This section covers:

Physical View

Logical View
Task View

Status Bar
Icons

Physical View

The physical view displays all the XPe devices registered with the XPe Management console.
Information and status of XPe devices is displayed in this view. If you choose to Auto group
devices based on the subnet range specified in the discovery option, the devices will be grouped
by the IP range.
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The physical view displays:

IP Address
MAC ID

Product version
Agent version —

Logical View

Computer Name — Windows Computer Name of the XPe device

DHCP - If the device is set to static IP DHCP field shows “NO "
Adapters — Number of network adapters installed on the XPe device
EWF State — Enhanced Write Filter state: Enabled/Disabled/Not present
Current State — XPe device state: Online/Offline

Product name —

Commercial product name

— Version of the XPe device build

XPe device agent version

For ease of management, the XPe devices registered with the management console can be
manually sorted into logical groups. Information and status of XPe devices is displayed in this

view.

Left pane displays created groups Right pane displays devices added to a selected group
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To create a group

To add XPe devices to groups

To create a group:

1. Right click in an empty space on the left pane of the logical view and click Add group.

2. Enter a logical name for the group and click OK. Example: Company Name for the main group

|

= f= Add group
e
Edit: aroup
Delete aroup [*YZ CORPORATION|

Add devices

Refresh

To create a sub group:

1. Right click on a created group in which a sub group has to be created and click Add group.

2. Enter a logical name for the sub group and click OK.

The following screenshot displays the group pane (left pane) of the logical view with groups and

sub groups.

== XYZ CORPORATION
lﬂ Accourts
...off] Engineering
-2 Sales
¢ -off Marcom

Sales support

ﬂﬂ Shipping

To add XPe devices to groups:

1. Right click on a group and click on Add devices.

» & Selact devices

Computer Name | IP Address | MAC Address | DHCP | Ad:
{4 OEM-M5BDOTAEP... 192.168.0.100 90-120251-38-87 Yes 1

Add group
Edit group
Delete group

% oK |  Cancel |

2. Select the devices from the select devices screen. To select multiple device hold Ctrl key and

click the devices to add.



Note: XPe devices can be added to the groups in the logical view only if they are registered with the XPe console. Refer
XPe device reqistration to register XPe devices in the Aurora management consoledatabase and are displayed in

the Physical view.
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The status bar is shown at the very bottom of the Management console and is visible in the
physical, logical and task views. The status bar displays the total number of XPe devices
registered with the Aurora management console and the total number of online devices.

Icons

The functions of the icons on the user interface are stated in the table.

Function

State

Discover new devices

Always active

Refresh current devices

Always active

R ||k d

Wakeup device

Active when device/s is selected

Restart device

Active when device/s is selected

Shutdown device

Active when device/s is selected

Remote Control (RDP)

H e

Active when device is selected

Shadow device (VNC)

ol

Active when device is selected

Clone settings

Active when device is selected

Manage installation packages

Always active

Add installation task

Active when device/s is selected

Options

€@’ ||&

Always active




Before you begin
This section includes:

Install license pack.

TCP/UDP port requirements

XPe device registration

Configure the Aurora console to use a FTP server
XPe device registration

Updating the agent on the XPe device

Install license pack

The default installation can manage up to 5 devices.

To install additional license pack for the installation product invoke the Aurora Management
console from the Desktop shortcut or Start Menu - Programs - Aurora for Windows embedded
- Aurora Management Console.

1. Click on the Help Menu - License...

File Edit Wiew Management Tasks\Packages Tools NEEl

F Contents, ..
P ¢ G Y= P .
= Bﬂm || Computg  License...

2. Copy the Host identity by clicking the “Copy to Clipboard” button.

License inf0 ®

M anaged devices info

MNumber of managed devices: 5

“Host info

Haost identity: |S-1-5-21-‘| 230593476-1560892923-369331 0909 Copy to Clipboard |
# Licenze Irnpuiirt I Cloze I

3. Email the Host identity to your sales or support contact.

4. Your sales/support contact will send you the link to a download a zipped license,xml file.
5. Extract the zipped license file to the Desktop or any convenient location.
6. Import the license.xml file by clicking on the “Import” button in the Help | License menu.

This license file will install the authorized number of licenses on this host.

Note: Do not open the license.xml file to keep its integrity. If you have any real time virus
scanner on your workstation/server disable it temporarily until you download, extract and import



the license file.

TCP/UDP port requirements

If the PC or Server on which the Aurora Management Console is installed has an Internet
connection firewall or Windows Firewall enabled, the following ports have to be opened.

See Table 1 for a list of standard port and see Table 2 for a list of custom ports required.

Table 1: Standard Ports:

67 & 68 | UDP PXE — Bootstrap used by Remote Boot Service
69 UDP TFTP — used by Remote Boot Service
20&21 | TCP If FTP server is installed on a PC or server which has a Firewall

Table 2: Custom Ports:

40000 | UDP XPe Agent/Server Communication
40001 | TCP XPe Agent/Server Communication
40002 | TCP XPe Agent/Server Communication

Network requirements for cross subnet environments:
1. The network should have port/broadcast enabled
2. ICMP should be enabled on the router

Configure the Aurora console to use a FTP server

To configure a FTP repository:

1. Create a FTP account with read/write, create directory, and browse directory permissions on

the FTP Server. The FTP Server should be accessible from the Aurora management console
and the XPe devices.

2. Logon to the FTP server and create a sub directory with a relevant logical name.
Example: Aurora

3. On the XPe Management console, click on the options icon or select Tools menu - options.



4. Select FTP setup tab.

5. If you had entered the ftp details during setup skip to step 7

(~ F0ptions =)
General Digcoven ] Remate Control ] D atabaze |
Uger Natification FTF Setup 1 Advanced ]
~FTP package storage

IP address:  |192.168.0.111

TCP port |

Home folder : |Aurora

User name |auru:ura

Pagzword |--------

Test FTP Settings

Ok Cancel

6. Enter the complete path to the FTP folder and enter login credentials.

7. Click “Test FTP Settings” to check if the FTP settings are valid.

o

7. If the FTP server connects, press OK to save settings.

8. This will be the root FTP repository used by the Aurora for Windows Embedded console

XPe device registration

XPe devices should be discovered and registered with the Aurora management consoleto carry
out the various management tasks. Devices can be discovered and registered in three ways.

e Automatic reqistration

e Regqistration using the Discovery option

e Specifying the Management server on the XPe device




Automatic registration

This is the default setting of the Aurora management console and XPe Agent. If the XPe devices
and the Aurora management console are in the same LAN segment, the devices get registered
with the console on the first boot.

Note: If the PC or Server on which the Aurora management console is installed has an Internet connection firewall
enabled, ensure that the required ports are open on the firewall. See TCP/UDP port requirements.

Registration using the Discovery option

The discovery option can be used to discover and register XPe devices in cross subnet
environments.

You will have to setup this option by clicking on the options icon and discovery tab or select
Tools menu - Options - Discovery tab.

zer Motification | FTP Setup ] Advanced |

| Remate Contral | Database |

s gl
[ Digcover devices in current subnet only

(* Specify subnet list o discover devices

Start: ; 3 3 End:

Skart End I
|

132.168.0.100 132.168.0120
19216816 152.1681.11

Connect timeot

* Usze default timeout

" Use this timeot: m

Ok Cancel

“Discover devices in current subnet only” is selected by default.

Select “Specify subnet list to discovery devices” and add range of IP addresses to discover XPe
devices. More than one subnet range can be added.

Click OK to exit the options.
Click discover new devices icon or select Management Menu - Discover new devices.

All new online XPe devices from the specified subnets should be discovered and added to the
database. Devices behind a NAT firewall will not be discovered using discovery.

Note: If devices are not discovered, check to see if the devices have an older agent (version: 1.0.65.0) with dual network
adapters (hardwired or wireless). Disable one adapter and try and discover the devices. Once discovered, select the
device in the console and upgrade the agent to the latest agent using the Tools menu | Upgrade old agent



Specifying the Management Server on the XPe device

This option should be used
o If multiple XPe management servers are installed on the network, the management
server that will be used to manage a particular XPe device has to be specified on the
XPe device.
o If the XPe device is behind a NAT firewall.

To configure this option on the XPe device:

1. Click Start Menu - Setup Panel on the XPe device.

{J setup Panel x|

Control Panel  Utilities |

2 o B &€ = -f

Tweak E'WF Manager Copy User Manager Wiew IP Config
Shortouts a...

Close

2. Click Utilities tab and double click XPe Agent icon.

= ¥ XPe agent settings

—Autodiscovering options

‘fou can gek a Management Server settings automatically,
Otherwise you should provide the correct Management
Server IF or DMS address,

% btain Management Server address automatically:

" Use the following Management Server address:

¥ 1P address: I o .o .0 .0

= DNS name: I

Device configuration options

[ This device is behind a Firewall

a4 I Cancel




3. The default option is “Obtain Management Server address automatically”.

4. Select “Use the following Management Server address” and specify the IP address or DNS
name of the Management Server.

5. If the XPe device is behind a NAT firewall select the check box “This device is behind a
Firewall”

5. Click OK. Commit changes to EWF using the EWF manager in the Setup Panel to make this
change persistent.

6. Reboot XPe device and the device should be registered with the Aurora console.
Updating the agent on XPe devices

Once XPe devices are registered with the Aurora console, check to see if the devices have the latest
agent. The current agent version is 2.0.72.0

If the devices have an older agent version select the devices with the old agent and upgrade the agent
using the Tools | options | Upgrade old agent.

5]

4 9

€

= Devices

| options... )A E

Save configuration settings. .

Apply configuration setkings... || MAC Address DHCP | EWF State | Curent State | Agent Yersion | Adapters | BehindFirewall
o 1 No

al |

D‘E Windows <Pe Update — 00-14-45fffe-86  Yes Enabled Orline Mo
ﬂﬂ “Windows CE 6, T oo toz tocoros 00-1a-5e-00-08-87  Yes Disabled Online 20720 1 Mo
indows i3 1620 -12-5e-00-0d- e hahle: nling 072 o
o] Windows #P OEM-JECDT0UOK... 1921680112 001252000410 ) Enabled Onl 20720 1 M
168,10, -1a5e-00-0d-2c “es nable nline o

OEM-<1R1R23UF4 192.168.0.114 001a-5e-00-0d-2c ! Enabled Onli 20720 1 M

- 168.0. -13-90-01-84-4 e nable ine: o

OEM-2IBYSABZHIT 192168.0112 0013-90-01-e4-25 Y, Enabled Ol 2.070.0 2 M

FAL NF MR T 192 1RA N1 AN13-90-M 497 Yes Frahled Mffline nzFnn ? Mn

This will create an agent update package and upgrade the agent on the selected XPe devices. On a
successful update the devices will be rebooted and the new agent version will be displayed in the
console.

Using the Aurora Management Console

This chapter covers the different functions or tasks that can be carried out on the remote XPe
devices by using the Aurora management server.

Tasks can be classified as:

e Frequently used tasks
o Refresh
o0 Wake up/Restart/Shutdown
o Remote Control/Shadow
e XPe device Initial setup tasks
o Change Computer name
0 Clone settings
e XPe device maintenance or upgrade tasks
o0 Managing hotfixes and application snap-ins
o Applying hotfixes and application snap-ins
0 Managing and applying Firmware Update packages




Frequently used tasks

Frequently used tasks include:

e Refresh
e Wakeup/Restart/Shutdown
¢ Remote Control/Shadow

Refresh
The refresh function gives the current Online/Offline status of the XPe device. To refresh you
click on the icon or hit function key F5 or View menu - Refresh

Wake up/Restart/Shutdown
The Wake up/Restart/Shutdown function provides power on, reboot, or shutdown of a remote
XPe device.

Note: To wake a client, the Wake On LAN support of the client's BIOS must be enabled.
To shutdown, reboot, or wake a client:

Select a device from the Physical View or Logical View and click on the
wakeup/restart/shutdown device icon.

To select multiple XPe devices hold the Ctrl key and select the devices with a left mouse click.

To select all the XPe devices right click in an empty space on the right pane of the physical or
logical view and select ‘all’ on the context menu or Edit Menu - select all

These functions are also available in the context menu when right click is performed on the
selected XPe devices, and on the Management menu.

Remote Control/Shadow
The Aurora management Server supports:

¢ Remote Desktop Connection (RDP) for Remote control of XPe device.

e VNC (Virtual Network Computing) for shadowing.

Remote Desktop Connection (RDP) for Remote control of XPe device

The XPe devices support Remote Desktop Protocol or Microsoft Terminal services. To start
Remote Control RDP session with an XPe device double click an online XPe device from the
physical or logical view. A remote XPe device logon screen will be presented. Log on as the XPe

device administrator.

Note:

1. Only one remote or local session is allowed on an XPe device. If the logon credentials provided are of a user with
admin privileges on the XPe device and a user session is open on the XPe device, the local user session is

disconnected and transferred to the Aurora Management Console.

2. If the logon credentials provided are of the administrator account on the XPe device and a user session is open on the

XPe device, the local user is logged off and a remote administrator session is opened on the Aurora Management
Console.



VNC (Virtual Network Computing) for shadowing
To use VNC for shadowing remote user sessions:

1. An Internet browser with Java plug-in support is required on the PC/Server with the
management console.

2. VNC service has to be enabled on the XPe device. The VNC service can be started from
Setup Panel - Control Panel - Services

3. Select VNC Server and change Startup to Automatic. Start the VNC service

4. To start a VNC session, select an XPe device from the physical or logical view and click on
the arrow beside the RDP icon. Select shadow via VNC. The default Internet browser on the
PC with the management software invokes to display the VNC authentication screen
prompting for the remote XPe device VNC password.

VNC shadows the remote users desktop and can be used for Help Desk activities.

Disconnest | Optians | [lipbaard | Send|ChlAl-Del |

VNC Authentication

Password: ok |

XPe device Initial setup tasks

The tasks that help to configure remote XPe devices for deployment include:
e Change Computer name/membership
e Clone Settings:
0 All Settings
Clone Display settings.
Clone Regional settings.
Clone Time Zone settings.
Clone Application settings.
Clone Network settings.
Clone Printer settings.
Clone Power settings.

OO0OO0OO0OO0OO0O0

To apply cloned settings packages to target XPe devices.




The screenshot displays the options on the Management menu. The change computer name
task can only be executed from the management menu.
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Change Computer name\membership..

The default Windows Computer Name is random generated starting with OEM — plus 11 alpha
numeric characters, which an administrator can change.

To change the Computer Name:
1. Select an online XPe device from the physical or logical view.

2. Select Management menu - Change nhame\membership...

( % Change name \ membership”

Y'ou can change the name and the membership of this device.
Changes may affect access to netwaork, resounces,

Mew device name;

I

td embier of

* [Dlomain

I

" “wWorkgroup

I

1t | Cancel

3. To join the XPe device to an Active directory or workgroup enter the Domain name or
workgroup in the fields provide. You should have the administrator privileges in the Active




Directory to add XPe devices to the domain. A popup window will prompt you for the domain
administrator credentials.

3. In the popup screen enter the credentials and click OK

4. The XPe device will reboot and its new Computer Name will be displayed once it is online.

Note: This operation can be carried out on one device at a time.
Clone settings

The cloned setting package provides the ability to set Display settings, Regional settings,
Application settings, and Time Zone settings on remote XPe devices using a configure XPe
device.. Configure an XPe device with the desired settings, test the settings, and then extract the
settings into a cloned setting package. The cloned setting package is saved on the FTP server.

This section covers:
Creating cloned settings packages:

All Settings

Clone Display settings.
Clone Regional settings.
Clone Time Zone settings.
Clone Application settings.
Clone Network settings.
Clone Printer settings.
Clone Power settings.

To apply cloned settings packages to target XPe devices.

To create cloned settings packages

1. To clone settings from a configured online XPe device, click on Tasks\Packages | Clone
device settings menu.

Clone ethings..,
Manage installation packages. ..

C R JONRS

=1 o Devices Add task. .. | IP Address | MAC Address
o] Windows P Edit 2 1921680103 O0-14-daff-fe-
off] Windows CE ste bash 192.168.0.112  00-1a-5e-00-0

one task 1921680114 001352000
Apply doned tasks... | 1921880112 001390006
() DEMMYSVTWIZ.. 1921680113 00138001
() OEM-7GD7IONQASE 192.168.0.114 00139001
(3 DEMVITGEIGES.. 1921680115 00139001

off] ‘Windows P

i

2. You will have the option to clone all the configured settings from the list of settings that can be
cloned or select individual settings. These settings can then be applied as a task to one or
more devices that are registered with the console.



Package name: 4!—\" settings from model device
Chaooze a type of settings to clone:
¥ Salact alf
v Display settings
v Regional settings
v Application settings

¥ Time Zone settings

<

Metwork. settings

¥ Printer settings

v Power settings

-~ Chooze a user name and password:

User name: |User

User passward: |....

ok, | Cancel

Clone Display settings:

1. Select an online model XPe device (An XPe device from which the settings have to be
copied) and click the clone settings icon or select Management menu - Clone settings

X

=''Clone Settings

Package name: JDispIaﬂ settings from model device

Chooze a type of settings to clone:

I Selectalf

¥ Display settings
Fegional settings
Application settiings

Time Zone settings

17 "

Metwork. settings

-

Frinter settings

Power settings

~Chooze a uzer name and password:

Uszer name: |User

Uszer passward: |.. .

QK | Cancel ‘

2. Check “Display settings” and enter a name for this package.
3. Enter the login credentials of the user or administrator account on the XPe device.

4. A package with the specified name will be created and uploaded to the FTP repository, which
can be used to change display settings on single or multiple XPe devices.



C'ln nie settings " W

Tupe of cloned settings: |Disp|a_l.-l @
Current operation: |Up|oading package to FTP repositany...

Caticel

Note: Administrator should ensure that cloned display properties are supported by the target XPe device monitors.

Clone Regional settings:

1. Select an online model XPe device and click the clone settings icon or select Management
menu - Clone settings

QL g i Eg]

Fackage name: ]Hegional settings from model device

Chooze a type of zettings to clone:
T Selecialt

I Dizplay settings

¥ Regional settings
I Application settings
I Time Zone setting:
I Metwark settings

[ Printer settings

I Power settings

~Choose a user name and password;

User name: juser

Uszer passward: J....|

ar. | Cancel J

2. Check “Regional settings” and enter a name for this package.
3. Enter the log in credentials of the user or administrator account on the XPe device.

4. A package with the specified name will be created and uploaded to the FTP repository, which
can be used to change Regional settings on single or multiple XPe devices.

Note: Clone regional settings, clones region specific settings like language and keyboard layout settings.
Clone Time Zone settings:

1. Select an online model XPe device and click the clone settings icon or select Management
menu - Clone settings



Package name:  |Time Zone settings from model device

Chooze a bype of settings to clone:
| Setectalf

| Digplay gettings

| Regional settings
Application settings

I Time Zone zettings

| Metwork settings

| Printer settings

| Power zettings

zer name: |

|Jzer pazsword; |

()4 | Cancel |

2. Check “time zone settings” and enter a name for this package and click OK

3. A package with the specified name will be created and uploaded to the FTP repository, which
can be used to change time zone settings on single or multiple XPe devices

Clone application settings

Clone application settings copies the contents of “Documents and Settings\user” directory from
the model XPe device. If ICA, RDP or any other applications are configured to connect to
specified servers and the connection shortcuts are created on the user desktop or Startup folder,
these connections will be copied to the Clone application settings package.

To create a Clone application package:

1. Select an online model XPe device (An XPe device from which the settings have to be copied)
and click the clone settings icon or select Management menu - Clone settings

2. Check “Application settings” and enter a name for this package. Click OK

3. A package with the specified hame will be created and uploaded to the FTP repository, which
can be used to change application settings on single or multiple XPe devices.



& Clone Settings

Package name: lAppIicatior‘ zettings from model device
Choose a type of settings to clone:
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I Dizplay settings
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W Application settings
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| Prinker settings

I Power settings
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IJger name: |
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Ok | Cancel
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Type of cloned settings: |App|icati0n @
Current operation; |Lc|g off device...

Cancel

4. The clone application package can take up to a minute to complete depending on the network
speed and FTP server connection. A progress bar indicating the status of the package
creation is displayed.

Clone network settings:
This will clone network settings like DHCP/Static, default gateway, DNS ..

Clone printer settings:

This is a great new feature available on this version of Aurora. You can install any local printer on a
model XPe device and use the clone printer settings to create a printer package. You can then install
the printers on one or multiple XPe devices.

If the model device has a network printer, only the printer drivers will be applied to the XPe device. We
may have to reconfigure the network printer on individual XPe devices.

Clone power settings:
Clone power settings copies the power setting like screen saver and other power settings. Note this is
a user specific setting and the settings from the



To apply cloned settings packages as a task to target XPe
devices

The cloned settings packages can be applied as a task to a single or to multiple XPe devices.
The tasks can be applied immediately or as a scheduled event.

To apply a cloned settings package:

1. Select the XPe devices from the physical or logical view to which the settings have to be
applied.

2. Right click on the selected XPe device and click Add task or click on Add task icon.

Run task

Task properties —

T ask Marne: | " Immediately

Task Type: |\nstallation Lj * Schedule

~Select package and user parameters for task.  — [ =

e One time only

Mame ] Type DatehTi i
% WindowsXP-KBIIE021-485ENU  Hotfix package Sieh me plons
%y Display settings from model devi...  Cloned settings package [Display) Start time: 1552 PM -l
% Application settings from model .. Cloned settings package [Application) Chart date: Ri2RI200 =
% ThinLabsdgentUpdate Hotfix package
L(i i [E3]

Uszer name;
User password:
o

[T Deletel [~ lgnore task options

I~ Ignore the task if device iz nat idle

I lgnore the task if device iz not idle more than: 0 Eli i1

t Cancel

3. If the task is of the type “Cloned settings package — Application” you will have an option to
apply this settings to the “Default User” profile and also delete all domain user profiles on the
selected remote XPe devices. This feature will is useful when joining XPe devices to an Active

Directory.

x|
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3. Select the required cloned settings package from the list.

4. Enter a name for the task.

5. Enter the XPe device user credentials if the field is active.

6. Select “Immediately” to apply the task immediately and click OK or

7. Schedule the task to run on a specific day at a specific time and click OK. Tasks, can be run
e Onetime

Hourly

Daily

Weekly

Monthly

Or On Demand

The Hourly, Daily and Weekly schedules are useful to Wake up, shutdown or restart remote
devices at a specified time every day.

If devices are offline, or are behind a firewall, the “On Demand “schedule can be used. If this
option is selected, the task will be applied the next time the device comes online or rebooted.

I ——
Fun task

O Immediately

f*+ Scheduls

Schedule task: Or demand ﬂ

D atehTime options [H oLy

Tazk will be shark E\;a;lgkly

tonthiy
On demand

lgnore task options

I lgrore the task if device iz not idle

I lgnare the task if device is not idle mare than: 1] 3: min

ok ‘ Cahcel

7. The status of the task will be displayed in the task view. The status indicates whether task
was immediate or scheduled, tasks in progress, success/failure and date and time of
completion.

8. On successful execution of the cloned setting task, the XPe devices on which the task was
applied will reboot after committing the changes to EWF-.

Refer to the figure of Task view.



Note: Wait for the completion of an applied task on the XPe device before applying another task. A task is considered
complete when the XPe device reboots after completion of the task and the status of the XPe device changes to
“online”

XPe device maintenance or update tasks

XPe device maintenance or update tasks include:

e Applying Microsoft security updates or hotfixes.
e Installing new applications or application upgrades — referred as application snap-in.
¢ Reloading a new version of firmware or a factory copy of the firmware.

Managing hotfixes and application snap-ins
Microsoft releases security updates and system enhancement updates periodically. These
updates and enhancements are referred to as hotfixes.

Hotfixes are packaged and released by the XPe device manufacturer. For ease of management
of hotfix inventory, the package is a self executable which will extract by default to the folder
“rootdir:\Program Files\Aurora for Windows Embedded\Hotfixes”.

Application snap-ins are new applications or upgrades to installed applications, packaged to be
deployed to remote XPe devices.

Application snap-ins are packaged and released by the XPe device manufacturer. For ease of
management of application Snap-ins inventory, the package is a self executable which will
extract by default to the folder “rootdir:\Program Files\Aurora for Windows Embedded\
application snap-ins”.

To manage hotfixes and application snap-ins:

1. Download the hotfix or application snap-in package provided by the manufacturer and execute
it on the work station/Server on which the Aurora Management server is installed.

2. Click on “manage installation packages” icon or Management menu > Manage packages.
Click “Add” to add a package.



" % Manage Installation Packages

MName ] Tupe ]
T Windows<P-KBI36021-%86-ENL  Hatfix package

Ty Display setings from model devi..  Cloned settings package (Display)

"% Application settings from model ... Cloned settings package [Application]
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Add... Remove 0k

3. Select Type: hotfix, application snap-in, custom firmware update or Firmware update.

=

M ame: 1

Twpe:  |Hotfix |

~Selecth Firrmware Update | ]
.. |Custorn Firrmware Update _
Hotfix f Application Snap-in Browsze...

[ o ] caea |

4. Click browse. By default the folder “rootdir:\\Program Files\Aurora for Windows
Embedded\Hotfixes".

or

“rootdir:\Program Files\Aurora for Windows Embedded\Application snap-ins” will open
depending on the type of package.

5. Expand the “Hotfix” folder or “Application snap-ins” folder and click on the folder with the hotfix
name or application snap-in name. Example: “MS05-001"

6. Click OK.

7. The package will be uploaded to the FTP repository.



The following screenshots explain a pictorial explanation of the steps to upload a hotfix or
application snap-in package to the FTP repository.
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Applying hotfixes and application snap-ins as a task to XPe devices

Hotfix and application snap-in packages uploaded to the FTP repository can be applied as a task
to a single or to multiple XPe devices. The tasks can be applied immediately or as a scheduled
event.

To apply a hotfix or application snap-in package:

1. Select the XPe devices from the physical or logical view to which the packages have to be
applied.

2. Right click on the selected XPe device and click Add task or click on Add installation task icon.

T ask properties 1 Run task
Task Mame: [windowsxP-KBI36021 w85-ENL| @ |mmediately
Task Type: i\nstallatinn Li " Schedule
Select package and user parameters for task
: Schedule task: | J
Mame | Type Rl .
%y Windows<P-KBI36021-x86-EML  Hotfix package | ’
%y Display settings from model devi...  Cloned settings package [Display) | Stark time: | o =
\i% ApPIicat\on seftings from madel ... Clon.ed settings package [Application) z e |7J
%4 ThinLabzAgentUpdate Hotfix package =
% Thinl ahzdnent Indate Hntfix narkans 1]
£ | | >
Uzer name:
User password: |
-
|_ 1ar
-
I lar I ( :‘ mmify
ak Cancel

3. Select the required package from the list.

4. Select “Immediately” to apply the task immediately or schedule the task to run on a specific
day at a specific time and click OK or schedule the task.

5. The status of the task will be displayed in the task view. The status indicates whether task
was immediate or scheduled, tasks in progress, success, failures and date and time of
completion.

6. On successful execution of the hotfix or application snap-in task, the XPe devices on which
the task was applied will reboot after committing the changes to EWF.

Refer to the figure of Task view

Note: Wait for the completion of an applied immediate task on the XPe device before applying another task. A task is
considered complete when the XPe device reboots after completion of the task and the status of the XPe device
changes to “online”

Managing and applying Firmware Update packages
Firmware Update refers to new version of firmware or a factory copy of the firmware.

Example:
New Version: Windows XP Embedded SP2 XPe firmware.



Factory copy of firmware: Version shipped with the XPe device.

Firmware update packages are released by the XPe device manufacturer. For ease of
management of Firmware Update package inventory, the package is a self executable which will
extract by default to the folder “rootdir:\Program Files\Aurora for Windows Embedded\Firmware
Update”

To manage Firmware update package:

1. Download Firmware update package provided by the manufacturer and execute it on the work
station / Server on which the Aurora Management server is installed.

2. Click on “manage installation packages” icon or Management menu - Manage packages.
Click “Add” to add a package.

Name:  |HELIOS-=Pe firmware]

Type: | Fimware Update -l

Select firmware package parameters

Firmyvare folder: |C:AProgram FilestAurara for windows Ermbe Brawse... |

Path to boot image: | Browse. ..

QK | Cancel

3. Select Type: Firmware Update.

4. Click browse. By default the folder “ rootdir:\Program Files\Aurora for Windows
embedded\Firmware Update” will open.

5. Browse “Firmware folder” and select the firmware version name. Example: “HELIOS-XPe
Firmware”.

6. Browse “Boot Image” and select the boot.sdi file.

7. Click OK.

8. The package will be uploaded to the FTP repository and the boot.sdi file will be copied to the
Remote Boot server downloads directory. This is a time consuming operation and the time for
completion depends on the size of the package, the FTP server and network speed.

To apply the Firmware Update Package:

1. Select the XPe devices from the physical or logical view on which the Firmware has to be
reloaded.



2. Right click on the selected XPe device and select “add task” or click on “Add installation task”
icon.

3. Select the required “Firmware update package” from the list.

4. Select “Run now” to apply the task immediately or schedule the task to run on a specific day
at a specific time and click OK.

5. The selected XPe devices will reboot with a recovery remote boot image, download the
specified firmware update package to the local flash medium and on a successful reload will
reboot with the new image locally.

Note: To use this feature the First Boot device in the BIOS should be set to “LAN” PXE boot. PXE boot is normally
limited to the local LAN segment. This is a time consuming operation and the time for completion of the task
depends on the size of the package, the FTP server and network speed.

Advanced settings of Aurora Management
Console

This chapter covers the additional options found in the Tools = Options menu:

General

Remote Control
Database

User Notification
Advanced

General
Polling Interval

The XPe device agent sends its online status to the management console every time it comes
up after a power on or a reboot.

When a shutdown or reboot task is issued to the XPe device, the offline status can be detected
by pressing the function key F5 or by clicking the refresh icon.

The poll function allows getting the status automatically. The polling interval can be set from the
Tools > Options > General tab.



Remote cortrol Database | FTP setup | Advanced |
General D y I User Notification

Polling interval settings

[¥ Enable polling operation

Polling interval: [oo0030 =

0K Cancel
I |

Polling is enabled by default and set to 5 minutes between polls. Polling can be disabled by un-
checking “Enable Polling operation”. The polling interval can also be changed.

Remote Control
The default Remote control protocol is set to RDP. This can be changed to VNC or vice versa
from Tools - Options > Remote Control.

General | Discovery I User Notification
Remote control | Database | FTPsetup | Advanced
—Select the remote management tool
Remote management tool:

—VNE settings

0K I Cancel

Database
The database source can be changed by using Tools - Options - Database. To change the
database, a valid Aurora database server and source has to be specified.



General | Discovery | User Notification |
Remote control Database | FTP setup I Advanced

Database server name:

Iﬂurom

Data source:

JAUR

Login name: Paszword:

ey

ISB

User Notification
This option is disabled by default.

Remote contral I Database I FTP setup | Advanced I
General | Discovery User Notification
—User's notification dialog parameters
[V Intersct with user
\Waiting interval: D0:00:30 =
Type the message to be displayed on the user's desktop:
This XPe device is going to reboot. ;I
| -

If this option is enabled, users will be notified before shutdown, restart or before tasks are
applied. The interval to display messages at Users desktop can also be set.



Advanced

General I Discovery I User Notification |

Remote contral I Database I FTP setup
Maximium number of concurrent threads

Threads : IH]I

0K I Cancel

Maximum number of concurrent threads defines the number of TCP/IP threads used for
discovering XPe devices. The default value is 10 threads, as Windows 2000 Professional and
Windows XP allow only 10 TCP connections at any instance.

If Aurora for Windows Embedded console is installed on Windows 2000/2003 server the number

of threads can be set to the maximum allowed concurrent threads allowed by the server to
increase the speed of device detection.

Addendum - New features
Auto group devices by subnet range

The physical view has an option to list discovered devices by their subnet range if a subnet
range is specified in the Options | Discovery | Specify list to discover devices.

User Motific. FTP Setup l Advanced |

Femote Contral | Databass |

General

" Discover devices in curment subnet anly

% Specify subret list to dizcover devices

Start: : . ; End

| Start End E
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Connect timeout
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" Use this imeout: ms
oK Cancel




To enable this click on View | Auto grouping menu and check “Enable auto grouping”

=iz 'Auto grouping settings

¥ Enable auto grouping

Start | End | Mame

192168.0.100 192 168.0.120
19216815 192162111

Edit Name ‘ ok, | Cancel
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Search device

You can search for a device by using the View | Search device menu and specifying the IP
address or device name.
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The management menu and the right click menu have a few more commands implemented from
build version 2.0.72.0

Change name /membership

This command will help to rename a device and/or help to join remote devices to a Windows
workgroup or Active directory. The device rename command can only be executed on one online
device at a time. You can join multiple devices to a domain simultaneously. To join the XPe
device to an Active directory or workgroup enter the Domain hame or workgroup in the fields
provide. You should have administrator privileges in the Active Directory to add XPe devices to
the domain. A popup window will prompt you for the domain administrator credentials.

Y'ou can change the name and the membership of this device.
Changes may affect access to nebwork, resources.

Mew device name;

tember of

* [Diamain
|

(" ‘Warkgroup

I

| Cancel




Change EWF state

This command will help to change the Enhanced Write Filter (EWF) settings on remote devices.
The operation can be carried out on one or multiple online selected devices in the console.

Tasks\Packages Tools Help

Discover new devices
% @ { Refresh current devices B @ @ @ ‘
[ o Dovices | Wakeup | IP &ddress

= "E windt  Pestart
off 11 Shutdawn
of it

lber M ame

= D-E Windi  Change name ) membership. ..

g Q| Change EWF state... M-OYHERYWIO... 192.168.0.101
el Change password... MAWKBPECCT...  192168.0.105
=af L S * M-KBOKPEKDN... 1921680106

: 1 Getdsvicglon. M-3MEZOCEPS.. 192.168.0.107

1 == Y VN VYT 192 1ean1n7

(*'¢Change EWF state

Y'ou zan change Enchanced YWhite Filter configuration.

~E'wWF commands
% EWF Enable

" EWF Dizable
" EWF Carnrnit

Ok, Cancel

You can change the EWF state to “Enable”, “Disable” or “Commit”. The command should take
effect on the selected devices and the remote devices should automatically reboot.

Change password

You can select multiple online devices and change the local “Administrator” and “User” account
passwords. You could also choose to apply the changed password to the device auto logon
settings.

Wiew

File Edit Tasks\Packages Tools Help

Discower new devices =
ﬁ% @ I Refresh current devices i é
[= Devices Wake up ater Name

= ﬂ'ﬂ Windl Restart
of] 1t Shut down

off 1{  Shadon >
=] Bﬂ Wind  Change name ', membership. ..

‘o] 1! Change EWF state. ., b-MEWT

Di 1' Change passward. .. b-FGOTIC
ool MAATGE

{  Get device log d-CFLIF.
=1 oM RUPW




(Cha nge [ocal account password

— Change local account infarmation for
@ Administrator

Mew pazsword: !

O User

Mew pazsword: I

[~ Apply new settings to automate the logon process

Ok, Cancel

Get device inventory info

This command will help you to get device inventory information and can work on one online
device at a time.

= Alirora Management Console
GEGERE =R TasksiPackages Tools Help

Ciscover new devices '
Refresh current devices ; é

Filz  Edit  Wiew

Wake up

Restart

Shut down !
Shadow 4 M-7048
Change name Y membership. .. i\-1-2.JEYE
Change EWF state, ., -bAvEY

Change password. ..

Get device log

§ DEM-1090

” iy oK U

‘Device inventory info

—Operating system info
‘ersion: |Microsoft Wwindows <P Embedded

Service pack: |Service Pack 2

— Hardware info

Total physical memary (MB]: |445

Total disk space [MB]: |9??
Free disk space (MB]: |392
Processar speed [MHz): |99?

—Installed applications

Adobe Flazh Player fctive:d

Adobe Reader 7.0.8

Citriz Presentation Server Client
Click-N-Type

Jawva[TH] SE Runtime Environment B Update 1
Microgoft MET Framework 2.0

Microgoft MET Framework 2.0

Microgoft Office Excel Viewer 2003
Microgoft Office PowerPaint Viewer 2003
Microgoft Office Word Viewer 2003
Penbdount Universal Driver 2.0.0,93

“l& Rhine-F amily Fazt-Ethernet Adapter




Deleting XPe devices

To delete registered XPe devices from the Aurora management console database:

1. Select the XPe devices displayed in the right pane of Physical view. To select multiple
devices hold the CTRL key and select the devices using the left mouse click.

2. Select Edit menu > Delete

Devices deleted from the physical view are removed from the database and will also be removed
from the logical view. Devices deleted from the logical view will be available in the Physical view

The deleted XPe devices can be re-registered by using the options explained in XPe device
registration.

Uninstalling

Aurora for Windows Embedded Console and server can be uninstalled through the Microsoft
Windows Control Panel > Add/Remove Programs. Select “Aurora For Windows Embedded”
and click Change/Remove. The program will be uninstalled.

Currently installed programs: [] show updates Sark by Eli';llame |:J
hange or T :

Remove
Programs

&

Add Mew
Programs

= |

._il AuktoHotkey 1,0,47.00 Size 2 55ME M

Note: The uninstaller program does not remove:
e  Remote boot Server
e .Net Framework 2.0
. SQL 2005 Express

e  These components have to be removed using their own uninstaller programs.
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